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PRINTING: WHY DOES IT  
SOMETIMES GO SO WRONG? 
 
More often than not, the root of printing issues lies 
in the planning stage. Problems like missing font 
versions, incorrect image colour spaces, or layouts 
unsuited to the chosen binding method can all lead 
to disappointing results. As much as we hate to 
admit it... the issue often starts with you. 
But don’t stress - we’re here to help!

Guiding customers through the complexities 
of Prepress is a personal mission and it’s a 
commitment shared by the entire team at 
Vanguard. That’s exactly why we’ve created 
this guide: to help you adopt best practices that 
will make your experience with our Prepress 
department, and the entire production process, 
smooth and stress-free.

Get it right in Prepress, and your project is well on 
its way to a successful journey through our Press 
and Postpress stages. That means:

• Staying within budget and saving money 
• Hitting deadlines and saving time 
• Reducing environmental impact 
• And taking some pressure off yourself

So, dive on in! You’ll be tapping into over 40 
years of Vanguard experience. And you’ll see how 
mastering Prepress can lead to flawless results - 
every single time.

CONTENTS
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PLANNING
LIKE BENJAMIN FRANKLIN SAID, “BY 
FAILING TO PREPARE, YOU ARE PREPARING 
TO FAIL.” AND LIKE OUR PREPRESS STAFF 
SOMETIMES SAY WHEN HAVING TO FIX 
BADLY PREPARED ART, “AT THIS RATE I’LL 
BE HERE UNTIL THREE IN THE MORNING.”

A little planning and preparation at the start will give your 
project its best chance of being completed efficiently, 
within budget and with pleasing quality.

So first, to ensure your project is on the right track from 
the start, ask yourself some questions:

1.	 What do I want to create and how do I achieve this?

2.	 How will my design work best and how do I need to 
set up my layout for the chosen binding method?

3.	 How is the stock I am printing on going to affect my 
images?

4.	 Can I afford to annoy Prepress staff by making them 
work until three in the morning to fix my oversights?

Quick Note on Supplying Artwork

To help us deliver your job smoothly and accurately, 
we kindly ask that you send artwork only once it’s fully 
complete; including all final text, images, and ads.

Sending unfinished files (even with the best intentions!) 
can lead to delays, increase the chance of errors, and 
often doesn’t speed things up overall.

We’re always here to help, so if you’re unsure whether 
your file is ready or have any questions, just ask. We’re 
always happy to guide you!

START PREPRESS RIGHT:  
GET THE BASICS SET FROM THE 
BEGINNING 
 
To ensure a smooth prepress process, start 
by setting your document to the correct size. 
Some design programs default to US Letter, 
so double-check this early on - it can save you 
from having to redo all your artwork later.

Next, set your bleed. Most artwork needs a 3mm 
bleed on all sides, but for perfect bound covers, 
we ask for 5mm.

Also, make sure your document is set to use 
CMYK (Cyan, Magenta, Yellow, Black) instead of 
RGB. RGB is for screens, not print and when it’s 
converted to CMYK, colours can shift and lose 
vibrancy. By working in CMYK from the start, 
you’ll get a much more accurate idea of how 
your final printed piece will look.

CREATING PRINT-READY ARTWORK: 
KEY TIPS
Keep your ink coverage below 320%. Too 
much ink takes longer to dry, which can cause 
smudging or pages sticking together. Never use 
registration black (100% of all CMYK colours) it 
adds up to 400% ink, which is far too much.

Rich blacks are okay, but avoid using them 
behind small white text. It’s harder for printers to 
align perfectly, which can make the white text 
look fuzzy or blurry.

When using photos or images, aim for a 
resolution of at least 225ppi, ideally 300ppi. 
Anything lower may look blurry or pixelated in 
print. 
Since photos and scans are usually in RGB, 
remember to convert them to CMYK for accurate 
colour printing. 
 
Finally, keep all text and important elements 
at least 3mm from the edge of the page. This 
avoids anything getting cut off during trimming.

SAVING YOUR ARTWORK AS A 
PRINT-READY PDF
When exporting your artwork to PDF, make sure 
all fonts are embedded or the text is converted 
to outlines. If fonts aren’t embedded, they may 
not print correctly unless we have the exact font. 
Outlining text solves this, but it makes editing 
harder and can slightly thicken the text. 
 
Even if you’ve added bleed to your design, some 
programs require you to manually select “include 
bleed” when exporting. If not selected, your PDF 
might export without it. Please also include crop 
marks on all projects to help ensure bleeds are 
trimmed inline.  
 
For magazines, or books, save your PDF as single 
pages (not spreads). We’ll handle page layout 
and single pages make the process smoother. 
 
Lastly, please order your pages from first to last. 
This helps prevent any pages being printed out 
of sequence.

PREPARATION
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BINDING OPTIONS
PERFECT BOUND JOBS: 
WHAT TO KNOW
Page content near the spine: Each page loses 
about 4mm into the spine, so the visible area 
is slightly narrower. Because spine visibility 
can vary (depending on glue and how far 
a book is opened), images or text across a 
spread may not line up perfectly. For best 
results, avoid placing anything important 
across the centre of two pages.

Cover spine: You’ll need to include a spine 
on your cover. If you’re unsure of the spine 
width, just ask your Vanguard representative.

Glue area: Leave a 5mm ink-free area on 
each side of the spine (inside the cover) to 
allow space for glue. The first and last pages 
of the document also need a 5mm ink-free 
margin on the spine edge.

Margin for readability: Keep all text and 
important elements at least 15mm away from 
the spine edge so they remain easy to read. 

SETTING UP WIRO BOUND JOBS
Wiro bound artwork must be set up as single 
pages, not spreads. Each page is trimmed 
on all four sides, so bleed is needed on every 
edge. This isn’t possible if the layout is done 
as spreads.

Also, remember to adjust your margins: left 
and right pages need different inner margins 
to make space for the wire binding.

Please note that no critical artwork should be 
within 20mm of the binding edge/spine of 
the book.

SADDLE STITCHING:  
THINGS TO KEEP IN MIND
Saddle stitch binding is flexible and easy to 
design for, but there are a few small things to 
watch out for.

Creep: As pages are folded together, the 
inner pages stick out slightly more — this 
is called creep. Don’t worry, Vanguard will 
check if your job needs creep adjustment. 
Just be careful not to place page numbers or 
important elements closer than 3mm to the 
edge, as this method isn’t perfectly precise.

Borders: Avoid using even borders on every 
page, as slight shifts during printing and 
binding can make them look uneven.

Fold-outs: If you’re including a fold-out page, 
make sure those pages are made narrower 
so they fold and trim correctly.

WHAT TO KNOW BEFORE YOU FOLD 
You don’t need to be an origami expert to get folding 
right, just a bit of planning can help you avoid problems. 
 
ROLL FOLD 
In a roll fold, each panel must get slightly smaller than 
the one before it so they fold neatly inside each other. 
Reduce each panel by about 2mm.

Try not to use too many folds, or your piece may 
become bulky. Heavier paper might need even more 
allowance — ask us if you’re unsure. 
 
CONCERTINA (ACCORDION) Z FOLD 
Concertina folds don’t need panels to be different 
sizes, but they have their own challenges. If the piece 
is supposed to stand up, you’ll need a sturdy paper 
stock. If it’s being mailed, it can be tricky to insert into 
envelopes automatically (go for a DLX envelope)  
 

4 PAGE
Half Fold

10 PAGE 
Concertina 
Fold

6 PAGE
Z Fold

8 PAGE
Roll Fold

6 PAGE 
Roll Fold

6 PAGE 
Single Gate Fold

8 PAGE 
Concertina 
Fold

8 PAGE 
Double Gate 
Fold

FOLDING  
YOUR PROJECT




EXAMPLE 2 - NO ALLOWANCE ADDED

EXAMPLE 1 
LEFT SIDE OF IMAGE MOVED 7MM LEFT 
RIGHT SIDE OF IMAGE MOVED 7MM RIGHT

Z FOLD 
ALL PANELS  
MEASUREMENTS 
ARE THE SAME SIZE

ROLL FOLD 
SHORTEST PANE 
MEASURES 2MM 
LESS THAT THE 
OTHER PANELS

FO
LD

FO
LD

FO
LD

100MM100MM100MM

100MM 100MM

98MM

FO
LD
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IMAGE RESOLUTION
GREAT PRINTING STARTS  
WITH GREAT ARTWORK
The final quality of your printed job depends on the 
quality of the artwork you supply. A “she’ll be right” 
attitude won’t cut it — good results come from good 
preperation!

First of all, use the right software. 
If you can, always stick to professional design 
programs when possible. Use Adobe InDesign or 
QuarkXPress for page layouts. Use Adobe Illustrator 
for logos and vector graphics - not for full layouts. Use 
Photoshop or Lightroom to edit and resize images.

Avoid using Microsoft Word, PowerPoint, Publisher, 
or CorelDraw as these are not programs designed for 
print ready artwork. 

If you opt to use Canva, please see our complete 
Canva guide on page 18-21. 
 
IMAGE PREP TIPS
Rotate and resize images in Photoshop before placing 
them into your layout.

Aim to place images at or near 100% size in your layout 
as this helps with speed and quality.

Low-resolution images will look pixelated. But images 
that are too high-res can slow things down or even 
cause issues. 
 
IMAGE RESOLUTION GUIDE
For colour or greyscale images: resolution should be 
twice the screen ruling. For example, at 175 lines per 
inch, use 350ppi.

Effective resolution matters: if a 300ppi image is 
scaled up to 200%, its effective resolution drops to 
150ppi.

Line art or bitmaps should be at least 600ppi.

Best practice: place images at 80%–120% of their 
original size for best results. 
 
PPI VS DPI
PPI (pixels per inch) refers to image resolution. 
DPI (dots per inch) refers to the resolution of the print 
device — our platesetter runs at 2540dpi.

Vanguard logo at 300ppi at print size and scaled up 400%

Vanguard logo at 150ppi at print size and scaled up 400%

Vanguard logo at 75ppi at print size and scaled up 400%

Image quality - PPI (Pixels Per Inch)
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COLOUR
USE CMYK FOR PREDICTABLE 
PRINTING RESULTS
For the best results in offset printing, use CMYK 
(Cyan, Magenta, Yellow, and Black) images & 
colour profiles. This is the colour model used by 
our printing presses. If your images are in RGB 
(Red, Green, Blue), they’ll need to be converted 
to CMYK. It’s best to do this conversion early on 
to avoid surprises later.

Since RGB has a wider colour range than 
CMYK, some colours won’t print the same. 
Converting to CMYK early lets you spot any 
colour shifts before you see the proof or final 
print.

There is a number of good ready made profiles 
around to be used for colour conversion. Here at 
Vanguard we suggest using Coated Fogra39, 
this profile is located within your Adobe Creative 
Suite software.

MANAGING COLOURS IN YOUR 
PRINT JOB
What colours will your job use? Are you printing 
with spot (PMS) colours, CMYK, or a mix of both?

To stay in control of your print job, make sure 
you only use the correct colours. If you’re using 
CMYK, convert any spot colours to CMYK 
in your document. Watch out for differences 
in how spot colours break down in different 
software versions - even the same program can 
give different results. Colour libraries change 
over time, which can affect how colours appear.

Always delete unused colours from your file.

To check if everything looks correct, you can 
view the separations:

In InDesign, press Shift + F6 (or go to 
Window>Output>Separations Preview).

In Acrobat Pro, go to Advanced>Print 
Production>Output Preview.

HOW TO EVALUATE COLOUR 
ACCURATELY
Don’t rely on how colours look on your computer 
screen unless it’s professionally calibrated. Even 
with calibration, your screen shows colours using 
RGB light (which is different from the CMYK 
pigments used in printing).

The best way to check colour accuracy is by 
using exact CMYK values or by reviewing a 
colour-calibrated proof.

Our printed proofs are carefully adjusted to 
match our printing process, offering the most 
accurate colour preview. 

TOTAL INK LIMITS & BLACKS
To avoid printing issues, keep your total ink 
coverage within these limits:

330% for coated stock

300% for uncoated stock 
(This total is the combined percentages of CMYK 
values.)

Going over these limits can cause slow drying, 
smudging, and delays — not ideal for quality or 
delivery.

For large black areas, use Rich Black so it doesn’t 
look dull. Here are two good Rich Black mixes:

100% Black + 40% Cyan or for a more neutral 
tone: 100% Black, 30% Cyan, 25% Magenta, 25% 
Yellow

Important: Avoid using Registration black as it 
will convert to plain black in our system and may 
cause issues.

100% Black 100% ink coverage

Blacks and ink coverage

Acceptable and desired for any black text. White text on it will be clear and sharp. 
No concerns for ink coverage.

The three above are acceptable. Shouldn’t be an issue for printers to register white text on it. 
No concerns for ink coverage.

The three above are acceptable. May present an issue for printers to register white text on it 
and it may appear a bit fuzzy, especially if the white text is small and thin. 
Most stocks will handle 300% ink coverage, but it may present issues for very light stocks.

Acceptable so long as there isn’t any white text on it. The four colours will make properly 
registering white text difficult. 
No concerns for ink coverage.

Acceptable so long as there isn’t any white text on it. The four colours will make properly 
registering white text difficult. 
High ink coverage. Many stocks can handle 320%, but it’s best not to push past this.

Not acceptable. Too much ink coverage will cause problems while printing. 

100% Cyan and 100% Black 200% ink coverage

100% Magenta and 100% Black 200% ink coverage

100% Yellow and 100% Black 200% ink coverage

100% Cyan, 100% Magenta and 100% Black 300% ink coverage

100% Cyan, 100% Yellow and 100% Black 300% ink coverage

100% Magenta, 100% Yellow and 100% Black 300% ink coverage

50% Cyan, 50% Magenta, 50% Yellow and 100% Black 250% ink coverage

80% Cyan, 80% Magenta, 80% Yellow and 80% Black 320% ink coverage

100% Cyan, 100% Magenta, 100% Yellow and 100% Black 400% ink coverage
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DIELINES, LAMINATION 
& VARNISHES
JOBS WITH DIELINES OR VARNISHES
If your job includes a diecut (forme cut), make 
sure the cutting shape is on its own separate 
layer in your design file. Clearly label this layer 
as “Die,” “Dieline,” or “Diecut.” The same goes 
for varnishes,  put them on their own layer and 
label them with the type (e.g. Gloss Varnish, Matt 
Varnish, or Spot UV).

Create the diecut as a separate spot colour 
named “Die,” “Dieline,” or “Diecut,” and make 
sure it is set to overprint. This prevents the die 
line from punching a hole in the artwork when 
printed.

If your software doesn’t support spot colours, 
you can use Registration Black for the dieline — 
but only use it for the die, nowhere else in your 
artwork. This makes it clear what is meant to be 
printed and what is not.

For presentation folders, the die is usually the 
trim box, so your artwork should include at 
least 3mm of bleed beyond the die line. The 
only exception is glue flaps, which are the areas 
used for assembly. Not all folders have glue flaps 
— if you’re unsure, 
ask your Vanguard 
representative.

If your design 
includes ink up to 
the edge of a glue 
flap, make sure 
it bleeds into the 
flap by 2mm to 
avoid white edges 
showing in the 
finished product.

HOW LAMINATION AFFECTS 
COLOUR IN PRINT
Lamination is a protective film applied over 
printed materials to increase durability and 
enhance the visual finish. However, it also affects 
how colours appear, particularly in terms of hue, 
vibrancy, and contrast. Here’s how:

GLOSS LAMINATION 
Affect on Colour: Gloss lamination intensifies 
colours, making them appear more saturated, 
vibrant, and richer.

How: The shiny surface reflects more light, which 
enhances contrast and gives colours a bolder 
appearance.

Resulting Shift: Whites appear brighter, blacks 
look deeper, and overall colours may appear 
slightly warmer or more vivid than the original 
print.

MATT LAMINATION 
Affect on Colour: Matt lamination softens 
colours, giving them a more muted or toned-
down look.

How: The non-reflective surface diffuses light, 
reducing contrast and vibrancy.

Resulting Shift: Colours may appear slightly 
duller or cooler, and blacks can take on a greyish 
tone. This finish offers a more subtle, elegant 
aesthetic but does alter the perceived intensity 
of the original colours.

WHY THIS HAPPENS 
Lamination doesn’t change the ink itself; it 
changes how light interacts with the surface. 
Since our eyes perceive colour based on how 
light reflects off a surface, different lamination 
finishes will result in slightly different colour 
outcomes. 
 
If accurate colour is critical, we recommend 
testing with a sample or proof to see how your 
chosen lamination will affect the final result.

 THIS IS HOW WE WANT PRESENTATION FOLDER 
ARTWORK TO BE SET UP. PLEASE NOTE THE 3MM OF 
BLEED EVERYWHERE EXCEPT ON THE GLUE FLAP WHICH 
ONLY HAS 2MM OF INK ON THE EDGE OF IT. 

 WHILE THE AMOUNT OF BLEED IS TOO MUCH 
(ESPECIALLY WHERE THIS TEXT IS), IT’S NOT 
TECHNICALLY WRONG AND WON’T CAUSE ANY 
TROUBLE FOR PREPRESS.

 THE REAL PROBLEM IS THE FLAP BEING COVERED 
IN INK WHICH WILL RESULT IN TROUBLE WHEN 
ATTEMPTING TO GLUE THE FOLDER TOGETHER. 

 THIS ARTWORK DOESN’T ANY BLEED 
AND THE GLUE FLAP DOESN’T HAVE ANY 
INK ON IT DESPITE IT REQUIRING SOME.

 THIS ARTWORK IS ALSO SET UP PROPERLY. THE 
GLUE FLAP IS LEFT COMPLETELY BARE BECAUSE 
THERE IS NO INK GOING UP NEXT TO IT THAT NEEDS 
TO BLEED OVER ONTO IT. MEANWHILE IN PLACES 
WHERE INK GOING TO THE EDGE OF THE DIE IT 
CONTINUES ONWARD AND BLEEDS 3MM PAST IT

WHAT IS...
INTERLOCKING VS GLUED
An interlocking folder is created to slot together 
with tabs, the glued version requires manual 
glueing to “stick” together parts of the folder. 
An interlocking folder is the most common type 
of presentation folder as it is a quicker, cheaper 
process and they are delivered flat, easy for storing. 

DIELINE 
A dieline is the blueprint for a layout created by 
a die cutter, a graphic designer, or a printer. It is 
highly essential in the die-cutting process, as this 
will be the main template for the artwork. It displays 
the fold line, the cut line, and the bleed line.

DIGITAL VS OFFSET 
Digital printing shines when lower quantities are 
needed. Offset printing cannot accommodate this 
need as offset is more involved and therefore has 
a higher minimum starting cost. Offset is great for 
large quantity runs where higher volumes mean a 
lower unit rate. 

A GUSSET (SPINE)?
A gusset creates two folds instead of a single fold 
in a presentation folder. A gusset is applied to a 
presentation folder’s flaps, which increases the 
pocket size. As a result more space is available to 
insert your documents.

PICK A DIELINE 
OR CREATE YOUR OWN!

Creating your own dieline is a great choice! This 
process does have a cost involved to produce 
the physical die cutting board, which is then 
stored at Vanguard for future use. 








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ERROR DETECTION
PREFLIGHT YOUR JOB
Before sending your artwork to print, it’s 
important to preflight your file in InDesign. This 
helps catch common issues like missing images, 
fonts, or overset text (where some text is hidden 
because it doesn’t fit in the text box).

 
HOW TO PREFLIGHT
Look for the preflight indicator in the bottom 
left corner of your InDesign window (next to the 
page numbers). 

 
 
    A green circle means all good!

    A red warning means something needs     
       fixing, click it to see what’s wrong and which    
       page it’s on.

 
COMMON ISSUES INCLUDE:
•	 Missing fonts: Go to Type > Find Font to 

replace them.

•	 Overset text: Expand the text frame so all 
your text is visible.

•	 Missing images: These need to be relinked. 
Click Relink and browse for the correct file.

When everything is green and error-free, you’re 
ready to package the file for print.

Tip: If an image is in RGB colour space and 
you’re printing digitally, it’s usually not a 
problem. It’s just a warning. If left as RGB, 
Vanguard will convert it to CMYK during 
printing.

 
WHY PACKAGING MATTERS
Unlike Word or PowerPoint, InDesign doesn’t 
embed images, it just links to them. So, when 
you send us your file, you also need to send the 
fonts and images you used. Packaging makes 
this easy. How to Package: Go to File > Package

WHAT DOES PACKAGING  
YOUR FILE DO?
•	 Makes a copy of your InDesign file

•	 Gather all the fonts and linked images

•	 Save everything in one folder, ready to send

NOTE: A missing image is a serious issue. It must 
be relinked, or it won’t print. Click Relink to fix it! 

 
WHAT HAPPENS NEXT?
If your file hasn’t been saved yet, InDesign will 
ask you to save it - click Save.

You’ll see a Printing Instructions box, add your 
name, contact, and any job notes here if needed.

Then choose where to save the folder. You can 
rename it if you’d like.

Make sure you tick:

	� Copy fonts

	� Copy linked graphics

	� Include IDML (if sending to someone with an 
older version of InDesign)

This creates a folder that includes:
•	 A copy of your InDesign file
•	 A .IDML file (for compatibility)
•	 A Fonts folder
•	 A Links folder

 
FINAL CHECKS
The Package Summary shows details like fonts, 
image links, and colour settings.

Any issues (like images in RGB instead of CMYK) 
will be flagged with a warning icon.

Click ‘Links and Images’, and tick ‘Show 
Problems Only’ to quickly spot and fix anything 
that needs attention.

Once all issues are resolved, compress the 
packaged folder and send it to us - we’re good 
to go! 
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EXPORTING & 
SUPPLYING FILES
Both InDesign and QuarkXPress have built-in 
tools to help you collect everything needed 
for printing. InDesign uses “Package” and 
Quark uses “Collect for Output.” We strongly 
recommend using these tools to gather all linked 
images and fonts before sending us your files.

Missing files or fonts will delay your job.

Also, make sure you send the correct version 
of each font. Fonts with the same name from 
different sources aren’t always the same and can 
cause text to reflow or shift slightly — which may 
not be obvious until it’s too late.

SUPPLYING PDFS
If you’re sending a press-ready PDF, please 
follow these guidelines:

•	 Export as single pages, not spreads

•	 Include at least 3mm bleed on all sides

•	 Add crop marks, offset by 3mm

•	 Ensure all fonts are embedded

•	 The file should be in CMYK (plus spot colours 
if used)

•	 Use high-resolution images

If any changes are needed after submission, you 
must send us a new corrected PDF.

HARD COPY PROOFS
If possible, include a printed laser copy of your 
job (ideally at 100% size).

If you’re sending files electronically, also send 
a viewing PDF as a reference — it can help us 
spot any issues and ensure everything prints 
correctly.

HOW TO SEND FILES
You can send your files via:

Our Website: 
vanguardmediagroup.com.au/File_Upload

Email or file transfer services  
(e.g. WeTransfer, Dropbox)

Or drop them off in person via USB drive or a 
hard drive, we always enjoy saying hello!

Trim
 m

ark to be cut alongFinal Product
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How to Supply Print-Ready Files from Canva!

To ensure the best possible print result, please 
follow these steps when exporting your artwork 
from Canva. 
 
STEP 1: CORRECT ARTBOARD SIZE
Set your document size to the final print dimensions 
(e.g., A4, DL, A5, etc.).

Under File, Settings, turn on “Show print bleed”

To avoid white borders after trimming, ensure all 
artwork bleeds out to the egde of your page.

STEP 2: KEEP TEXT AND CRITICAL 
CONTENT SAFE!
Keep all text and logos at least 3mm inside the 
edge of your document. This is called the safe zone 
and ensures nothing important gets trimmed off.

STEP 3: CHECK IMAGE QUALITY
All images should be high resolution, ideally at 300 
DPI or have a file size of 1mb or higher. 

Avoid using low-res or blurry images, as these won’t 
print clearly.

STEP 4: USE CMYK COLOUR MODE  
(IF AVAILABLE)
Canva works primarily in RGB, but can print in CMYK 
if you have Canva Pro.

Expect some colour shifts, bright colours 
especially may appear duller in print!

We recommend you print a test proof if colour 
accuracy is critical.

RGB 
Screen

CMYK
Printed

ON SCREEN VS PRINTED 
What you see on screen & how it will print

3mm Safe Margins
3mm Bleed

STEP 5: EXPORT AS PRINT-READY PDF
1.	 Click Share (top right)

2.	 Select Download

3.	 Choose PDF Print from the File Type menu

4.	 Tick Crop marks and bleed

5.	 Set Colour Profile to CMYK if available  
(Pro users only)

6.	 Click Download 

STEP 6: DOUBLE-CHECK YOUR PRINT 	
READY PDF
•	 Make sure all text is visible and spelled correct

•	 All images look crisp

•	 Colours look correct

•	 Bleed and crop marks are included

•	 No strange spacing or alignment issues

STEP 7: SEND TO US
The final PDF file (with crop marks and bleed)

A low-res version or screen preview  
(optional but helpful for checking)

LOGOS & VECTORS
Logos and other vector graphics should be provided as 
EPS, AI, vector PDF, or SVG files. PNG and JPEG formats 
are not scalable and may appear blurry when printed, 
this is especially noticable for larger work. 

 

AVOID:
•	 Supplying JPG, PNG or Word files for print

•	 Forgetting bleed and crop marks

•	 Using low-res images or screenshots

•	 Sending multiple versions without clear instructions

If you need help or have questions, we’re happy to 
walk you through the process, just reach out!

PNG / JPEG

EPS / AI / VECTOR PDF / SVG
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FOR SIGNAGE
When designing signage in Canva, we recommend 
scaling your artwork down to 25% of the actual size. 
Canva has limitations when it comes to custom bleed 
settings, and our signage requires a 70mm bleed. To help 
you get the best results, we’ve put together a guide to 
ensure the artwork you submit meets our requirements 
and is print-ready. Ensure when you set up your 
document its in MM and not PIXLES.

TYPE SIZE 25% + BLEED

4x3 ft 1220 x 900mm 340 x 260mm

6x2 ft 1800 x 610mm 485 x 187.50mm

6x3 ft 1800 x 900mm 485 x 260mm

6x4 ft 1800 x 1220mm 485 x 340mm

8x4 ft 2400 x 1220mm 635 x 340mm

6x8 ft 1800 x 2400mm 485 x 635mm

Margins & Bleed

When you’re ready to download your file, please ensure the following settings are used:

1.	 Select PDF Print as the file type.

2.	 Set the Colour Profile to CMYK if you have Canva Pro.

3.	 Do not select crop marks or bleed – the bleed has already been built into the artboard, and enabling 
these options will place them incorrectly. Our printer will handle scaling and manually add crop 
marks as needed.

4.	 Include “25%” & “Canva” in the file name to indicate the artwork is scaled down. The bleed on a sign will wrap 
around the edge like above
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CONTACT US 
T	 (08) 9328 1388 
E	 hello@vanguardmediagroup.com.au 
W	vanguardmediagroup.com.au
A	 26 John Street, Northbridge


